SmartChart V1.6

Copyright (C) 2004 - 2008 Trading-Tools.com
mailto:info@trading-tools.com

User manual
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>2</td>
</tr>
<tr>
<td>Welcome</td>
<td>4</td>
</tr>
<tr>
<td>Main Window</td>
<td>5</td>
</tr>
<tr>
<td>Plotting an ASCII File</td>
<td>6</td>
</tr>
<tr>
<td>Plotting a Microsoft Access (*.mdb) File</td>
<td>8</td>
</tr>
<tr>
<td>Preferences Dialog</td>
<td>9</td>
</tr>
<tr>
<td>Price Plots</td>
<td>13</td>
</tr>
<tr>
<td>Introduction</td>
<td>13</td>
</tr>
<tr>
<td>Modifying a Price Plot</td>
<td>13</td>
</tr>
<tr>
<td>Indicators</td>
<td>15</td>
</tr>
<tr>
<td>What is an Indicator?</td>
<td>15</td>
</tr>
<tr>
<td>Adding an Indicator</td>
<td>15</td>
</tr>
<tr>
<td>Deleting an Indicator</td>
<td>16</td>
</tr>
<tr>
<td>Supported Indicators</td>
<td>16</td>
</tr>
<tr>
<td>Accumulation Swing Index</td>
<td>16</td>
</tr>
<tr>
<td>Aroon Index and Oscillator</td>
<td>16</td>
</tr>
<tr>
<td>Bollinger Bands</td>
<td>17</td>
</tr>
<tr>
<td>Fractal Chaos Bands</td>
<td>17</td>
</tr>
<tr>
<td>Chaikin Money Flow</td>
<td>17</td>
</tr>
<tr>
<td>Chaikin Volatility Oscillator</td>
<td>18</td>
</tr>
<tr>
<td>Comparative Relative Strength</td>
<td>18</td>
</tr>
<tr>
<td>Ease of Movement</td>
<td>19</td>
</tr>
<tr>
<td>High Low Bands</td>
<td>20</td>
</tr>
<tr>
<td>High Minus Low</td>
<td>20</td>
</tr>
<tr>
<td>Linear Regression</td>
<td>20</td>
</tr>
<tr>
<td>Moving Average Convergence / Divergence (MACD)</td>
<td>20</td>
</tr>
<tr>
<td>Mass Index</td>
<td>21</td>
</tr>
<tr>
<td>Median Price</td>
<td>21</td>
</tr>
<tr>
<td>Momentum Oscillator</td>
<td>21</td>
</tr>
<tr>
<td>Money Flow Index</td>
<td>21</td>
</tr>
<tr>
<td>Moving Average Envelope</td>
<td>22</td>
</tr>
<tr>
<td>Negative Volume Index</td>
<td>22</td>
</tr>
<tr>
<td>On Balance Volume</td>
<td>22</td>
</tr>
<tr>
<td>Parabolic SAR</td>
<td>22</td>
</tr>
<tr>
<td>Performance</td>
<td>23</td>
</tr>
<tr>
<td>Positive Volume Index</td>
<td>23</td>
</tr>
<tr>
<td>Price Oscillator</td>
<td>23</td>
</tr>
<tr>
<td>Price Rate of Change</td>
<td>24</td>
</tr>
<tr>
<td>Price and Volume Trend</td>
<td>24</td>
</tr>
<tr>
<td>Rainbow Oscillator</td>
<td>24</td>
</tr>
<tr>
<td>Relative Strength Index (RSI)</td>
<td>24</td>
</tr>
<tr>
<td>Simple Moving Average</td>
<td>25</td>
</tr>
<tr>
<td>Prime Numbers Bands</td>
<td>25</td>
</tr>
<tr>
<td>Prime Numbers Oscillator</td>
<td>25</td>
</tr>
<tr>
<td>Standard Deviations</td>
<td>25</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Stochastic Oscillator</td>
<td>26</td>
</tr>
<tr>
<td>Fractal Chaos Oscillator</td>
<td>26</td>
</tr>
<tr>
<td>Swing Index</td>
<td>26</td>
</tr>
<tr>
<td>Time Series Moving Average</td>
<td>27</td>
</tr>
<tr>
<td>Trade Volume Index</td>
<td>27</td>
</tr>
<tr>
<td>Triangular Moving Average</td>
<td>27</td>
</tr>
<tr>
<td>TRIX</td>
<td>27</td>
</tr>
<tr>
<td>Stochastic Momentum Index</td>
<td>28</td>
</tr>
<tr>
<td>Average True Range</td>
<td>28</td>
</tr>
<tr>
<td>Typical Price</td>
<td>28</td>
</tr>
<tr>
<td>Ultimate Oscillator</td>
<td>28</td>
</tr>
<tr>
<td>Variable Moving Average</td>
<td>29</td>
</tr>
<tr>
<td>Vertical Horizontal Filter</td>
<td>29</td>
</tr>
<tr>
<td>VIDYA</td>
<td>29</td>
</tr>
<tr>
<td>Volume Oscillator</td>
<td>30</td>
</tr>
<tr>
<td>Volume Rate of Change (ROC)</td>
<td>30</td>
</tr>
<tr>
<td>Weighted Close</td>
<td>30</td>
</tr>
<tr>
<td>Weighted Moving Average</td>
<td>30</td>
</tr>
<tr>
<td>Welles Wilder's Smoothing</td>
<td>31</td>
</tr>
<tr>
<td>Williams’ Accumulation/Distribution</td>
<td>31</td>
</tr>
<tr>
<td>Williams’ %R</td>
<td>31</td>
</tr>
<tr>
<td>Line Studies</td>
<td>32</td>
</tr>
<tr>
<td>Ellipse</td>
<td>32</td>
</tr>
<tr>
<td>Error Channels</td>
<td>32</td>
</tr>
<tr>
<td>Fibonacci Arcs</td>
<td>32</td>
</tr>
<tr>
<td>Fibonacci Fans</td>
<td>32</td>
</tr>
<tr>
<td>Fibonacci Retracements</td>
<td>32</td>
</tr>
<tr>
<td>Fibonacci Time Zones</td>
<td>33</td>
</tr>
<tr>
<td>Gann Fan</td>
<td>33</td>
</tr>
<tr>
<td>Quadrant Lines</td>
<td>33</td>
</tr>
<tr>
<td>Raff Regression</td>
<td>33</td>
</tr>
<tr>
<td>Rectangle</td>
<td>33</td>
</tr>
<tr>
<td>Speed Line</td>
<td>33</td>
</tr>
<tr>
<td>Tirone Levels</td>
<td>34</td>
</tr>
<tr>
<td>Trend Line</td>
<td>34</td>
</tr>
<tr>
<td>FAQ (Frequently asked questions)</td>
<td>35</td>
</tr>
<tr>
<td>Registration and Price Information</td>
<td>37</td>
</tr>
<tr>
<td>Upgrade</td>
<td>39</td>
</tr>
<tr>
<td>Contact</td>
<td>40</td>
</tr>
<tr>
<td>Disclaimer of Warranty</td>
<td>41</td>
</tr>
</tbody>
</table>
Welcome
Managing your stock trading activity with “Smart Chart” is a cinch. The package includes:

- Over 30 of the most popular technical indicators into the charting software so you have access to the likes of Bollinger Bands, Moving Average Envelopes, MACD, Moving Averages, R.S.I, A.T.R, Standard Deviation, Typical Price Volume, Money Flow Index, Weighted Moving Average, Volume Oscillator, and many more.
- View your data in a number of formats like HLC Bars, OHLC Bars, Candlesticks, Candlevolume, Equivolume, Shaded Equivolume, Kagi, Renko, Three Line Break, Point and Figure, and more. These objects are available in 2D or 3D styles.
- Interact with charts. (Write notes, draw trend lines, and draw support/resistance levels as per M.S.T.S.)
- Following line studies are supported: Ellipse, Rectangle, Speed Line, Gann Fan, Fibonacci Arcs, Fibonacci Fan, Fibonacci Retracements, Fibonacci Time Zones, Tirone Levels, Quadrant Lines, Raff Regression, and Error Channels.
- Darvas Boxes
- EOD and intraday data are supported - All indicators update as prices change.
- Charts can be exported to image files or can be print out.
- Data can be updated automatically by the programs RTQDownloader (in real-time, you will see no screen flickering) and MLDownloader.
- SmartChart can read practically any ASCII file and plot the data. Alternatively, SmartChart can also read MetaStock files (all versions) and Microsoft Access database files (*.mdb)
- Google news can be displayed automatically.
- Receives stocks news as soon as they happen by using Google Alerts.
Main Window

On the left window you can select whether to display the contents of an ASCII or MetaStock directory or Microsoft Access database files. First, you have to select a root directory where these data files are stored. (By clicking on the “…” button) Afterwards, all subdirectories will be displayed in the window. A chart window will be displayed on the right side if you click on a security. A new chart window will be created for each security. You can use the ◁ and ▶ buttons to navigate through a directory. Click on the icon in the toolbar to hide the left window. So you can display all the charts in “full screen” mode.

Additionally, you can also define a list with your favorite securities. To add a security to the favorite list you have to click with the right mouse button on a security in the “Ascii” or “MetaStock” tab.
All securities that are stored in your favorite list can be displayed at the same time by clicking on the “Open all securities” button.

“News” tab window
If you are interested in news of a security you can click on the “News” tab. The program automatically goes to the “Google News” (http://news.google.com/) site and displays the latest news of the selected security.

“Notes” tab window
You can enter any information you want in the “Notes” textbox. The information that you have entered will be stored when you close the chart. When you open the chart the notes will be displayed again.

Plotting an ASCII File

Smart Charts assumes that all ASCII files with e.g. the extension “.txt” have the same format on your computer. Therefore you have to specify an ASCII format for each file extension. (e.g. csv, prn, dly etc.)

To define the ASCII file format, click on the “File” menu and select the “Ascii File Format Settings”. 
Firstly, enter the file extension. E.g. txt. Every time when a file with the extension e.g. “txt” will be opened Smart Chart uses the settings you have specified for this file extension.

**Available ASCII fields**
Tick the checkboxes corresponding to the data field which you want to include into the format. You can change the field order using drag & drop technology.

**Detail Settings**
You should choose which character would be used as the field delimiter. That character pertains to all columns and data in the file.

You can select the Date field format in your ASCII source. There are different formats supported. **Example 1:** YYYY-MM-DD means that the year is expressed as a four-digit number and that the three fields are separated by a “-” character. **Example 2:** MMDDYY means that the year, month and day are expressed as a two digit numbers each no characters separate the fields.

Third, you can select if you want the first N rows to be ignored. Use this if your ASCII source has column titles or other non-financial information.
Plotting a Microsoft Access (*.mdb) File

Select the “MS Access database” tab in the main window to plot an Access file. Afterwards, click on the “…” button to search for the database file you want to open. After you have done this, following dialog will appear:

Firstly, you have to select whether the quotes of all securities are stored in one table or if a separate table exists for each security. A table where the quotes of multiple securities are stored must contain a field that stores the symbol information. The field name can be different in each database. Therefore you have to manually enter the value.

If a password is required for your database file, then you have to tick off the option “Database is locked with a password”. Afterwards, you have to enter a username and password. In most cases the username is “Admin”.

Secondly, you have to define the fields that are available in your database file. Tick the checkboxes corresponding to the data field which you want to include. You can change the field order using drag & drop.

If your table looks like the following then you have to tick off the fields “Symbol”, “Date”, “Open”, “High”, “Low”, “Close”, “OpenInterest”, “Volume”.

("Access Database File" dialog)
It does not matter if the fields have other names than “Open”, “High” etc. You can give them any name you want. It is only important that you have selected all fields that are available in the database and that they are in a correct order.

Finally, you have to define the date and time format.

**Note:**
You have to make sure that SmartChart can read data from the table “MSysObjects”. Make sure that you have ticked off the “Read Data” checkbox in the “Tools->Security->User and Group Permissions” dialog.

![User and Group Permissions dialog](image)

**Preferences Dialog**

Click on “Options->Preferences” to display following dialog:
Automatically update active chart every xx seconds
Select this option to update the active chart every xx seconds. You should use this option if the data is updated by an external program.

Example: Let us assume that you have a program that downloads real time data for you and stores this data in MetaStock format. SmartChart can read these MetaStock files and displays a chart. To get the chart updated automatically you have to select this option. If you do not select this option you have to refresh the chart manually.

Display news tab
Select this option to display a “News” tab in the chart window. By clicking on this tab you can display news of the currently opened security. Moreover, you can select whether to display the news in English, French, German, Italian or Spanish language.

Google News Alert Settings
Google Alerts are email updates of the latest relevant Google results (web, news, etc.) based on your choice of query or topic. So you can easily create alerts for those stocks that you are interested in. SmartChart automatically detects the news emails from Google and displays them in the main window.

First, you have to select the option “Check for Google News every xxx minutes”. Afterwards, select an interval how often SmartChart should
connect to your email account and check for new Google news emails. You can specify an interval from 1 to 300 minutes.

That SmartChart can read the Google news emails you have to specify the name of your POP3 server, your POP3 user name and POP3 password. (POP3: stands for "Post Office Protocol". The standard email protocol used to receive emails)

**POP3 server**
Address of your POP server. Check with your email provider for this address.

**POP3 Username**
Typically this is the first part of your email address (e.g. "username").

**POP3 Password**
The password to access your POP3 account. Your email provider will tell you this.

To set up an email alert go to [http://news.google.com](http://news.google.com) Following page will be displayed:

![Google Alerts](https://i.imgur.com/3Q470.png)

In the “Search terms” field you have to enter the name of the stock that you are interested in. Then select “News” in the “Type” field and select “as it happens” in the “How often” field. Finally, enter your email address and
click on the “Create Alert” button. After you have done that you will receive an email from Google that asks you to confirm the alert. If you have already set up SmartChart to read the Google news emails following dialog will be displayed:

![Confirm Google Alert dialog](image)

After you have pressed the “Confirm Alert” button Google will start to send news emails to your email account. Please be aware that it may take some time until Google sends the first news email to you.
Price Plots

Introduction
Smart Chart provides nine ways to view the pricing information: Candlesticks, Candle Volume, Equivolume, Equivolume Shadow, Kagi, High/low/close bars, Line, Point & Figure and Renko.

Line charts require only closing prices to plot, whereas Candlesticks require all four pieces of pricing information--open, high, low, and close. And as their names imply, Equivolume and Candle volume incorporate volume into the price plot.

Certain line studies (i.e., cycle lines, Gann grids, and Fibonacci Time Zones) plot unevenly on Equivolume and Candle Volume charts. This is because the distance between time periods on these charts varies. The same line studies, when plotted on Kagi, Point & Figure, Renko, and three line break charts, also produce results inconsistent with normal interpretation.

Indicators calculated on Kagi, Point & Figure, Renko, and three line break charts use all the data in each column and then display the average value of the indicator for that column.

Modifying a Price Plot
To modify a price plot click the “Styles” menu, then select the “Price Style” submenu and then click on the price style you want to have. Moreover, you can also define whether the price plot will be displayed in 3D style or not. (Styles->3D Style menu)

To change the color of the price plots, click on the “Color” menu.

Up Color
Click on this menu point to select the color when the closing price moves upward (as compared to the previous period's price).

Down Color
Click on this menu point to select the color when the closing price moves downward (as compared to the previous period's price).

Volume Color
Click on this menu point to change the color of the volume.

Fore Color
Click on this menu point to change the chart’s fore color. (X-scale and y-scale text)

Back Color
Click on this menu point to change the chart’s back color.

**Grid Color**
Click on this menu point to change the chart’s grid color. (Horizontal and vertical)
**Indicators**

*What is an Indicator?*

An indicator is a mathematical calculation that can be applied to a security's price, volume or even to another indicator. The result is a value that is used to anticipate future changes in prices. Indicators are plotted either in a separate inner window or overlaid in the base security's inner window (e.g., a moving average).

**Adding an Indicator**

To add an indicator to your chart, click on the “Chart” menu and click on the “Add Indicators” entry. The Indicator dialog lets you choose the indicator and the inner window in which it should be plotted.

The Indicator dialog lets you choose an indicator and the inner window in which it should be plotted. You can select one indicator from the Indicators list on the left side of the dialog. Pick an inner window in which to plot the indicator from the Inner Windows list on the right side of the dialog.

The inner windows listed on the right side of the dialog are labeled Inner Window #1, Inner Window #2, etc. corresponding with the location (top to bottom) in the chart.
If you choose New Inner Window, the indicator is plotted in a new inner window at the top of the chart.

After you have clicked the OK button, a dialog where you can set the indicator properties will be displayed:

![Indicator Properties dialog]

The property dialog is different for each indicator. To get more information of an indicator parameter click in the corresponding text field. A brief parameter description will be displayed at the bottom of the dialog.

**Deleting an Indicator**

You can delete an indicator by right-clicking on the indicator plot and choosing Delete from the shortcut menu. You can also delete an indicator by selecting the indicator and pressing the DEL key.

**Supported Indicators**

**Accumulation Swing Index**

The Accumulation Swing Index (Wilder) is a cumulative total of the Swing Index.

**Interpretation:**
The Accumulation Swing Index may be analyzed using technical indicators, line studies, and chart patterns, as an alternative view of price action.

**Parameters:**
Limit Move Value

**Aroon Index and Oscillator**
The Aroon indicator is often used to determine whether a stock is trending or not and how stable the trend is.

**Interpretation:**
Trends are determined by extreme values (above 80) of both lines (Aroon up and Aroon down), whereas unstable prices are determined when both lines are low (less than 20).

Parameters:
- Periods

**Bollinger Bands**
Bollinger Bands are similar in comparison to moving average envelopes. Bollinger Bands are calculated using standard deviations instead of shifting bands by a fixed percentage.

**Interpretation:**
Bollinger Bands (as with most bands) can be imposed over an actual price or another indicator. When prices rise above the upper band or fall below the lower band, a change in direction may occur when the price penetrates the band after a small reversal from the opposite direction.

Parameters:
- Source
- Periods
- Standard Deviations
- Moving Average Type

**Fractal Chaos Bands**
The chaotic nature of stock market movements explains why it is sometimes difficult to distinguish hourly charts from monthly charts if the time scale is not given. The patterns are similar regardless of the time resolution. Like the chambers of the nautilus, each level is like the one before it, but the size is different. To determine what is happening in the current level of resolution, the fractal chaos band indicator can be used to examine these patterns.

Parameters:
- Periods

**Chaikin Money Flow**
The Chaikin Money Flow oscillator is a momentum indicator that spots buying and selling by calculating price and volume together. This indicator is based upon Chaikin Accumulation/Distribution, which is in turn based upon the premise that if a stock closes above its midpoint \([(\text{high}+\text{low})/2]\) for the day then there was accumulation that day, and if it closes below its midpoint, then there was distribution that day.

Parameters:
- Volume Source
- Periods
**Chaikin Volatility Oscillator**
The Chaikin Volatility Oscillator is a moving average derivative of the Accumulation/Distribution index.

**Interpretation:**
The Chaikin Volatility Oscillator adjusts with respect to volatility, independent of long-term price action.

**Parameters:**
Periods  
Rate of Change  
Moving Average Type

**Chande Momentum Oscillator (CMO)**
The Chande Momentum Oscillator (Chande) is an advanced momentum oscillator derived from linear regression.

**Interpretation:**
Increasingly high values of CMO may indicate that prices are trending strongly upwards. Conversely, increasingly low values of CMO may indicate that prices are trending strongly downwards. CMO is related to MACD and Price Rate of Change (ROC).

**Parameters:**
Source (open, high, low, close or volume)  
Periods

**Commodity Channel Index**
The CCI was developed by Donald Lambert. The purpose of this indicator is to identify cyclical turns in commodities.

**Interpretation:**
This indicator oscillates between an overbought and oversold condition and works best in a sideways market.

**Parameters:**
Periods

**Comparative Relative Strength**
The Comparative Relative Strength index divides one price field by another price field.

**Interpretation:**
The base security is outperforming the other security when the Comparative RSI is trending upwards.

**Parameters:**
Source 1 (open, high, low, close or volume)  
Source 2 (open, high, low, close or volume)
**Detrended Price Oscillator**
The Detrended Price Oscillator is used when long-term trends or outliers must be removed from prices or index indicators.

**Interpretation:**
This indicator is often used to supplement a standard price chart. Other indicators can be plotted over the Detrended Price Oscillator.

**Parameters:**
- Source (open, high, low, close or volume)
- Periods
- Moving Average Type

**Directional Movement System**
The Welles Wilder's Directional Movement System contains five indicators; ADX, DI+, DI-, DX, and ADXR.

The ADX (Average Directional Movement Index) is an indicator of how much the market is trending, either up or down: the higher the ADX line, the more the market is trending and the more suitable it becomes for a trend-following system. This indicator consists of two lines: DI+ and DI-, the first one being a measure of uptrend and the second one a measure of downtrend.

Detailed information about this indicator and formulas can be found in Welles Wilder's book, "New Concepts in Technical Trading Systems". The standard Directional Movement System draws a 14 period DI+ and a 14 period DI- in the same chart panel. ADX is also sometimes shown in the same chart panel.

**Interpretation:**
A buy signal is given when DI+ crosses over DI-; a sell signal is given when DI- crosses over DI+.

**Parameters:**
- Periods

**Ease of Movement**
The Ease of Movement oscillator shows a unique relationship between price change and volume.

**Interpretation:**
The Ease of Movement oscillator rises when prices are trending upwards under low volume, and likewise, the Ease of Movement oscillator falls when prices are trending downwards under low volume.

**Parameters:**
- Volume
Periods
Moving Average Type

**Exponential Moving Average**
An Exponential Moving Average is similar to a Simple Moving Average. An EMA is calculated by applying a small percentage of the current value to the previous value. An EMA applies more weight to recent values.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.

Parameters:
Source (open, high, low, close or volume)
Periods

**High Low Bands**
High Low Bands consist of triangular moving averages calculated from the underlying price, shifted up and down by a fixed percentage, and include a median value.

Interpretation:
When prices rise above the upper band or fall below the lower band, a change in direction may occur when the price penetrates the band after a small reversal from the opposite direction.

Parameters:
Periods

**High Minus Low**
Returns the high price minus the low price.

**Linear Regression**
Linear regression is a common statistical method used to forecast values using least squares fit.

Parameters:
Source (open, high, low, close or volume)
Periods

**Moving Average Convergence / Divergence (MACD)**
The MACD is a moving average oscillator that shows potential overbought/oversold phases of market fluctuation. The MACD is a calculation of two moving averages of the underlying price/indicator.

Interpretation:
Buy/Sell interpretations may be derived from crossovers (calculated from the Signal Periods parameter), overbought/oversold levels of the MACD and divergences between MACD and actual price.
Parameters:
Long Cycle
Short Cycle
Signal Periods

**Mass Index**
The Mass Index identifies price changes by indexing the narrowing and widening change between high and low prices.

Interpretation:
According to the inventor of the Mass Index, reversals may occur when a 25-period Mass Index rises above 27 or falls below 26.5.

Parameters:
Periods

**Median Price**
A Median Price is simply an average of one period’s high and low values.

Interpretation:
A Median Price is often used as an alternative way of viewing price action, and also as a component for calculating other indicators.

**Momentum Oscillator**
The momentum indicator calculates change of over a specified length of time as a ratio.

Interpretation:
Increasingly high values of the momentum oscillator may indicate that prices are trending strongly upwards. The momentum oscillator is closely related to MACD and Price Rate of Change (ROC).

Parameters:
Source (open, high, low, close or volume)
Periods

**Money Flow Index**
The Money Flow Index measures money flow of a security, using volume and price for calculations.

Interpretation:
Market bottoms below 20 and tops above 80. Divergence of price and Money Flow Index are also used.
**Moving Average Envelope**

Moving Average Envelopes consist of moving averages calculated from the underlying price, shifted up and down by a fixed percentage.

Interpretation:
Moving Average Envelopes (or trading bands) can be imposed over an actual price or another indicator. When prices rise above the upper band or fall below the lower band, a change in direction may occur when the price penetrates the band after a small reversal from the opposite direction.

Parameters:
- Source (open, high, low, close or volume)
- Periods
- Moving Average Type
- Shift: Shift is a double value specifying the percentage of shift for each moving average from the actual values.

**Negative Volume Index**

The Negative Volume Index shows focus on periods when volume decreases from the previous period.

Interpretation:
The interpretation of the Negative Volume Index is that well-informed investors are buying when the index falls and uninformed investors are buying when the index rises.

Parameters:
- Source (open, high, low, close or volume)
- Volume

**On Balance Volume**

The On Balance Volume indicator shows a relationship of price and volume as a momentum index.

Interpretation:
On Balance Volume index generally precedes actual price movements. The premise is that well-informed investors are buying when the index rises and uninformed investors are buying when the index falls.

Parameters:
- Source (open, high, low, close or volume)
- Volume

**Parabolic SAR**

The Parabolic SAR was developed by Welles Wilder. This indicator is always in the market (whenever a position is closed, an opposing position is taken). The Parabolic SAR indicator is most often used to set trailing
price stops. A stop and reversal (SAR) occurs when the price penetrates a Parabolic SAR level.

Parameters:
Min AF (accumulation factor)
Max AF (accumulation factor)

Performance
The Performance indicator calculates price performance as a normalized value or percentage.

Interpretation:
A Performance indicator shows the price of a security as a normalized value. If the Performance indicator shows 50, then the price of the underlying security has increased 50% since the start of the Performance indicator calculations. Conversely, if the indicator shows –50, then the price of the underlying security has decreased 50% since the start of the Performance indicator calculations.

Parameter:
Source (open, high, low, close or volume)

Positive Volume Index
The Positive Volume Index shows focus on periods when volume increases from the previous period.

Interpretation:
The interpretation of the Positive Volume Index is that many investors are buying when the index rises, and selling when the index falls.

Parameters:
Source (open, high, low, close or volume)
Volume

Price Oscillator
The Price Oscillator shows a spread of two moving averages.

Interpretation:
The Price Oscillator is basically a moving average spread. Buying usually occurs when the oscillator rises, and conversely, selling usually occurs when the oscillator falls.

Parameters:
Source (open, high, low, close or volume)
Long Cycle
Short Cycle
Moving Average Type
**Price Rate of Change**
The Price ROC shows the difference between the current price and the price one or more periods in the past.

**Interpretation:**
A 12-day Price ROC is most often used as an overbought/oversold indicator.

**Parameters:**
Source (open, high, low, close or volume)
Periods

**Price and Volume Trend**
The Price and Volume Trend index is closely related to the On Balance Volume index.

**Interpretation:**
The Price and Volume Trend index generally precedes actual price movements. The premise is that well-informed investors are buying when the index rises and uninformed investors are buying when the index falls.

**Parameters:**
Source (open, high, low, close or volume)
Volume

**Rainbow Oscillator**
The rainbow oscillator is based upon multiple time frames of a moving average.

**Interpretation:**
When values stay above 80 or below 20, the trend may reverse suddenly.

**Parameters:**
Source (open, high, low, close or volume)
Levels
Moving Average Type

**Relative Strength Index (RSI)**
The RSI (Wilder) is a popular indicator that shows comparative price strength within a single security.

**Interpretation:**
9, 14 and 25 period RSI calculations are most popular. The most widely used method for interpreting the RSI is price/RSI divergence, support/resistance levels and RSI chart formations.

**Parameters:**
Source (open, high, low, close or volume)
Periods
**Simple Moving Average**
The Simple Moving Average is simply an average of values over a specified period of time.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.

Parameters:
Source (open, high, low, close or volume)
Periods

**Prime Numbers Bands**
Similar to the Prime Numbers Oscillator, the prime numbers oscillator was developed by Modulus Financial Engineering, Inc. This indicator finds the nearest prime number for the high and low, and plots the two series as bands.

Interpretation:
This indicator can be used to spot market trading ranges.

**Prime Numbers Oscillator**
The prime numbers oscillator was developed by Modulus Financial Engineering, Inc. This indicator finds the nearest prime number from either the top or bottom of the series, and plots the difference between that prime number and the series itself.

Interpretation:
This indicator can be used to spot market turning points. When the oscillator remains at the same high point for two consecutive periods in the positive range, consider selling. Conversely, when the oscillator remains at a low point for two consecutive periods in the negative range, consider buying.

Parameters:
Source (open, high, low, close or volume)

**Standard Deviations**
Standard Deviation is a common statistical calculation that measures volatility. Other technical indicators are often calculated using standard deviations.

Interpretation:
Major highs and lows often accompany extreme volatility. High values of standard deviations indicate that the price or indicator is more volatile than usual.

Parameters:
Source (open, high, low, close or volume)
Periods
Standard Deviations
Moving Average Type

**Stochastic Oscillator**
The Stochastic Oscillator is a popular indicator that shows where a security’s price has closed in proportion to its closing price range over a specified period of time.

**Interpretation:**
The Stochastic Oscillator has two components: %K and %D. %K is most often displayed as a solid line and %D is often shown as a dotted line. The most widely used method for interpreting the Stochastic Oscillator is to buy when either component rises above 80 or sell when either component falls below 20. Another way to interpret the Stochastic Oscillator is to buy when %K rises above %D, and conversely, sell when %K falls below %D.

**Parameters:****
%K Periods
%K Slowing
%D Periods
Moving Average Type

The most commonly used arguments are 9 for %K periods, 3 for %K slowing periods and 3 for %D smoothing.

**Fractal Chaos Oscillator**
The chaotic nature of stock market movements explains why it is sometimes difficult to distinguish hourly charts from monthly charts if the time scale is not given. The patterns are similar regardless of the time resolution. Like the chambers of the nautilus, each level is like the one before it, but the size is different. To determine what is happening in the current level of resolution, the fractal chaos oscillator can be used to examine these patterns.

**Parameters:****
Periods

**Swing Index**
The Swing Index (Wilder) is a popular indicator that shows comparative price strength within a single security by comparing the current open, high, low and close prices with previous prices.

**Interpretation:**
The Swing Index is a component of the Accumulation Swing Index

**Parameters:****
Limit Move Value
**Time Series Moving Average**
A Time Series Moving Average is similar to a Simple Moving Average, except that values are derived from linear regression forecast values instead of raw values.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.

Parameters:
Periods

**Trade Volume Index**
The Trade Volume index shows whether a security is being accumulated or distribute (similar to the Accumulation/Distribution index).

Interpretation:
When the indicator is rising, the security is said to be accumulating. Conversely, when the indicator is falling, the security is said to being distributing. Prices may reverse when the indicator converges with price.

Parameters:
Volume
Minimum Tick Value

**Triangular Moving Average**
The Triangular Moving Average is similar to a Simple Moving Average, except that more weight is given to the price in the middle of the moving average periods.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.

Parameters:
Source (open, high, low, close or volume)
Periods

**TRIX**
TRIX is a momentum oscillator that shows the rate of change of an exponentially averaged closing price.

Interpretation:
The most common interpretation of the TRIX oscillator is to buy when the oscillator rises and sell when the oscillator falls. 3, 8 and 14 period moving averages are often used to smooth the TRIX oscillator.

Parameters:
Stochastic Momentum Index
The Stochastic Momentum Index, developed by William Blau, first appeared in the January 1993 issue of Stocks & Commodities magazine. This indicator plots the closeness relative to the midpoint of the recent high/low range.

Interpretation:
The Stochastic Momentum Index has two components: %K and %D. %K is most often displayed as a solid line and %D is often shown as a dotted line. The most widely used method for interpreting the Stochastic Momentum Index is to buy when either component rises above 40 or sell when either component falls below 40. Another way to interpret the Stochastic Momentum Index is to buy when %K rises above %D, and conversely, sell when %K falls below %D.

Parameters:
%K Periods
%K Smoothing
%K Double Smoothing
%D Periods
Moving Average Type
%D Moving Average Type

The most commonly used arguments are 13 for %K periods, 25 for %K smoothing, 2 for %K double smoothing, and 9 for %D periods.

Average True Range
The Average True Range (Wilder) measures market volatility.

Interpretation:
High ATR values may signal market bottoms, and low ATR values may signal neutral markets.

Typical Price
A Typical Price is simply an average of one period’s high, low and close values.

Interpretation:
A Typical Price is often used as an alternative way of viewing price action, and also as a component for calculating other indicators.

Ultimate Oscillator
The Ultimate Oscillator compares prices with three oscillators, using three different periods for calculations.

Interpretation:
The most popular interpretation of the Ultimate Oscillator is price/indicator divergence.

Parameters:
Cycle 1
Cycle 2
Cycle 3

**Variable Moving Average**
A Variable Moving Average is an exponential moving average that adjusts to volatility.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.

Parameters:
Source (open, high, low, close or volume)
Periods

**Vertical Horizontal Filter**
The Vertical Horizontal Filter (VHF) identifies whether a market is in a trending or choppy movement phase.

Interpretation:
The VHF indicator is most commonly used as an indicator of market volatility. It is also frequently used as a component for other technical indicators.

Parameters:
Source (open, high, low, close or volume)
Periods

**VIDYA**
VIDYA (Volatility Index Dynamic Average), developed by Chande, is a moving average derived from linear regression R2.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator. Because VIDYA is a derivative of linear regression, it quickly adapts to volatility.

Parameters:
Source (open, high, low, close or volume)
Periods
R2 Scale

R2Scale is a double value specifying the R-Squared scale to use in the linear regression calculations.
Chande recommends a value between 0.5 and 0.8 (default value is 0.65).

**Volume Oscillator**
The Volume Oscillator shows a spread of two different moving averages of volume over a specified period of time.

Interpretation:
The Volume Oscillator offers a clear view of whether or not volume is increasing or decreasing.

Parameters:
Volume
Short Term
Long Term
Points Or Percent (output scale type)

**Volume Rate of Change (ROC)**
The Volume Rate of Change indicator shows clearly whether or not volume is trending in one direction or another.

Interpretation:
Sharp Volume ROC increases may signal price breakouts.

Parameters:
Volume
Periods

**Weighted Close**
Weighted Close is an average of each day’s open, high, low, and close, where more weight is placed on the close.

Interpretation:
The Weighted Close indicator is a simple method that offers a simplistic view of market prices.

**Weighted Moving Average**
A Weighted Moving Average places more weight on recent values and less weight on older values.

Interpretation:
A Moving Average is most often used to average values for a smoother representation of the underlying price or indicator.

Parameters:
Source (open, high, low, close or volume)
Periods
Welles Wilder's Smoothing
The Welles Wilder's Smoothing indicator is similar to an exponential moving average. The indicator does not use the standard exponential moving average formula. Welles Wilder described 1/14 of today's data + 13/14 of yesterday's average as a 14-day exponential moving average.

Interpretation:
This indicator is used in the manner that any other moving average would be used.

Parameters:
Source (open, high, low, close or volume)
Periods

Williams' Accumulation/Distribution
The Accumulation/Distribution indicator shows a relationship of price and volume.

Interpretation:
When the indicator is rising, the security is said to be accumulating. Conversely, when the indicator is falling, the security is said to be distributing. Prices may reverse when the indicator converges with price.

Williams' %R
Williams' %R measures overbought/oversold levels.

Interpretation:
The most widely used method for interpreting Williams' %R is to buy when the indicator rises above 80 or sell when the indicator falls below 20.

Parameters:
Periods
Line Studies

Ellipse
An Ellipse is a non-analytical drawing tool used to highlight specific portions of a chart you believe are significant. For example, Ellipses can highlight a group of bars signifying an upward or downward trend.

You can also use Ellipses in conjunction with analytical tools. For example, you might use Ellipse templates to signify what you believe are market reversals. You can then apply a study that identifies market reversals to determine if your non-analytical interpretation meets the criteria of the analysis technique for market reversals. Combining non-analytical drawing tools with analytical tools allows you to gauge how well you are able to visually identify market phenomenon before incorporating technical analysis studies in your chart.

Error Channels
Standard Error Channels are calculated by plotting two parallel lines above and below an x-period linear regression trend line. The lines are plotted a specified number of standard errors away from the linear regression trend line.

Fibonacci Arcs
Fibonacci Arcs are created on a chart by first drawing a trend line between two extreme points, a trough and opposing peak. Three arcs are generated that are centered on the second extreme point and intersect the trend line at Fibonacci Levels, usually of 38.2%, 50% and 61.8% of the distance between a price maximum and minimum. The interpretation of Fibonacci Arcs involves looking for support and resistance as prices approach the arcs. Fibonacci Arcs and Fibonacci Fan Lines are sometimes used together to anticipate support and resistance at the points where the Fibonacci studies intersect.

Fibonacci Fans
Fibonacci Fan Lines are displayed by first drawing a trend line between two extreme points, a high and low. An invisible vertical line is drawn through the second extreme point. Three lines are then drawn from the first extreme point (the leftmost point) passing through the invisible vertical line with their slopes at the Fibonacci levels, usually 38.2%, 50.0% and 61.8%. These lines indicate areas of support and resistance.

Fibonacci Retracements
Fibonacci Retracements are displayed by locating two extreme points, a trough and opposing peak. Five lines are drawn: 100% (the high on the chart), the second at 61.8%, the third at 50%, the fourth at 38.2%, and the last one at 0% (the low on the chart). These price levels often correspond to areas of support and resistance.
Fibonacci Time Zones
Fibonacci time zones are composed by dividing a chart with vertical lines spaced apart in a ratio adhering to the Fibonacci number sequence (1, 1, 2, 3, 5, 8, 13, etc.). The interpretation of Fibonacci Time Zones involves looking for significant price movement near the vertical lines. Also known as Fibonacci Time Series.

Gann Fan
A Gann Fan is drawn between a significant bottom and top (or vice versa) at various angles.

The idea here is to use any of the fan lines as either support (when retracing an uptrend) or resistance (when retracing a downtrend). Once a support line gives, for instance the 2X1 line, it turns into resistance, and the next one, 3X1, turns into support. This gives the trader a trading range that is difficult to fathom with the naked eye, Gann fan lines work best on medium to long-term charts.

Quadrant Lines
Quadrant Lines are horizontal lines which divide distance between High and Low of the period into four equal parts. The user defines two points on the price chart, and between them 3 Quadrant Lines are plotted. For significant results, Quadrant Lines should be drawn between a high and low point of price activity on a chart.

Raff Regression
The Raff Regression helps to identify possible areas of support and resistance and helps to identify when departures from the channel may signal potential changes in the price trend in the future.

Rectangle
A Rectangle is a non-analytical drawing tool used to highlight specific portions of a chart you believe to be significant. For example, you can highlight important areas for in-depth analysis and demonstration.

You can also use Rectangle in conjunction with analytical tools. For example, you might use Rectangle to signify what you believe to be market reversals. You can then apply a study that identifies market reversals to determine if your non-analytical interpretation meets the analysis technique’s criteria for market reversals. Combining non-analytical drawing tools with analytical tools allows you to gauge how well you are able to visually identify market phenomenon before incorporating technical analysis studies in your chart.

Speed Line
Speed Lines is an analytical drawing tool used to identify the support and resistance of a trend and the price level possible trend correction. A Speed Lines tool consists of an underlying trend line on which speed resistance
lines are drawn above (representing time) and below (representing price). These speed lines are drawn based on time/price percentages of the distance between the beginning and the end of that underlying trend line.

Speed Lines were developed by Edson Gould and are based on dividing an underlying trend line by the percentages specified, for example, into third - 1/3 and 2/3. Speed lines help to measure trend correction and also the rate a trend line is ascending or descending - in other words, the speed of the trend.

**Tirone Levels**
Tirone Levels are a series of horizontal lines that identify support and resistance levels. They were developed by John Tirone. Tirone Levels indicates possible price movements from important highs and lows. Tirone Levels displays five lines ranging between the extreme high and lows and the adjusted mean price.

To draw a Tirone Levels on a chart two points must be defined: a point High to which there corresponds a ceiling price, and a point Low where price is minimal. The price distance between points is accepted for a unit of measurements - Range.

**Trend Line**
Trend Line is one of the basic analytical charting tools for detecting the principal trend. With the Trend Line one can estimate the strength as well as possible trend reversal points.

Trend lines are possibly the most useful and valuable tool in the study of market trends. Trend lines are utilized in chart analysis to determine the slope of the market trend and assist in ascertaining when the trend is changing. For the purposes of this explanation, up trend lines and down trend lines will primarily be used. Up trend lines are drawn under the rising stock chart lows. Upward moving trend lines are drawn under the stock connecting the dips to easily target a possible entry point. Down trend lines are drawn above the declining stock chart peaks. Downward moving trend lines are drawn on top of the stock, connecting rallies to easily target a shorting possibility. Markets rise and fall at a given slope. Trend lines help traders determine the slope of a given stock.

Trend Lines can assist in determining trends and can also alert you to changes in trend. They are easily applied to a chart and once applied can be easily adjusted, moved, extended or even duplicated.
FAQ (Frequently asked questions)

Q: When I try to open an ASCII file I always get following error message:

A: SmartChart can practically read any ASCII file. But it is necessary to tell the program in which format the ASCII files are. You can specify the format in the “Options->Ascii File Format Settings” dialog. Here is an example how to define the ASCII format correctly:

Let us assume that there is an ASCII file called “Microsoft.txt”. The file contains following records:

<table>
<thead>
<tr>
<th>Date</th>
<th>Open</th>
<th>High</th>
<th>Low</th>
<th>Close</th>
<th>Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005/07/01</td>
<td>24.85</td>
<td>24.99</td>
<td>24.67</td>
<td>24.71</td>
<td>69718392</td>
</tr>
<tr>
<td>2005/07/05</td>
<td>24.66</td>
<td>25.19</td>
<td>24.62</td>
<td>24.98</td>
<td>61883500</td>
</tr>
<tr>
<td>2005/07/06</td>
<td>24.97</td>
<td>25.08</td>
<td>24.69</td>
<td>24.70</td>
<td>64214600</td>
</tr>
<tr>
<td>2005/07/07</td>
<td>24.58</td>
<td>24.71</td>
<td>24.50</td>
<td>24.65</td>
<td>80082896</td>
</tr>
</tbody>
</table>

To display this file correctly you have to make following settings in the “ASCII File Format Settings” dialog:
The file “Microsoft.txt” has the extension “txt”. Therefore you have to enter “txt” in the file extension textbox. Furthermore, you have to select the ASCII fields “Date”, “Open”, “High”, “Low”, “Close” and “Volume”. As column delimiter you have to use “,”. Finally, you have to define the date format. (YYYY/MM/DD)

In this example we have to select the option “Skip first … records” because the file contains a file header. (Date, Open, High, Low, Close, Volume) If your ASCII file does not contain such a header you do not have to select this option.

Q: Will Smart Chart be able to read the new Metastock format directories which support 6000 symbols?

A: Yes SmartChart can read up to 6000 symbols per directory. The program supports the old and the new MetaStock format.
Registration and Price Information

Product price (one time payment, free updates): 59.95 EURO

If you decide to buy the programs MLDownloader and SmartChart you get both programs for only 99.95 EURO instead of 119.90 EURO.

This copy of Smart Chart is available for a 14 days evaluation period. If you decide to continue using the program, you need to register the program by using one of the methods described below. By registering the software, you are able to continue using it legally, and are supporting our efforts to continually develop innovative products to best serve your needs. If you order via credit card you receive the fully registered version of SmartChart within 5 minutes.

Privacy: ShareIt or PayPal keeps your credit card info; we do not ever see it. In any case, we do not share, sell, or otherwise distribute any of your personal data. We resent companies who do this to us, so we certainly will not do it to you.

Click on the link below to make your order on a secure web site. You can pay via credit card, wire transfer, cash or check.  
http://shareit1.element5.com/product.html?productid=131029&languageid=1

Save 60 Euro – get one application for free - if you buy MLDownloader, SmartChart and IndicesBuilder! You get these applications for 119.95 Euro instead of 179.95 Euro.  
http://shareit1.element5.com/product.html?productid=189955&languageid=1

Special discount for MLDownloader and SmartChart
If you decide to buy MLDownloader and IndicesBuilder you get both programs for only 99.95 Euro instead of 119.90 Euro. You save 20 Euro!  
http://shareit1.element5.com/product.html?productid=157010&languageid=1

Benefits of Registering:
• No restrictions on the number of starts
• Free updates
• Free technical support provided by email. Questions usually answered within 24 hours.

We also accept orders via PayPal!
After you have placed your order, you will receive an unlock key within 24
hours. Go to http://www.paypal.com and log in into your account. Click on "Send Money". Enter "info@trading-tools.com" in the "Recipient's Email" text box. Also enter your name and the name of the program you want to order in the "subject" text box. Click on continue to complete the order.
Upgrade

If you are a registered user of Smart Chart you may upgrade at no charge to any newer release. Just download the latest release of Smart Chart and install it.

If the registration code is no longer present on your system just re-enter it like the first time and restart the program.

If for any reason your registration code becomes invalid or lost just send an e-mail to info@trading-tools.com together with the details of your previous registration. You will receive a new code via e-mail at no charge.
Contact

We provide support via email. You can email your questions, comments or bug reports to info@trading-tools.com. Normally all emails are answered throughout the 24-hour day. Please take a look at the FAQ. Perhaps your question is already answered there.

Keep the following tips in mind:

**Software Problems:** It is easier to solve a software problem if you send us details that are as specific as possible when inquiring about software problems. Also tell us the operating system you are using.

**Data Problems:** Again, details that are as specific as possible is necessary in order to resolve any data problems quickly. Please specify the stock name and the date in question when reporting a data problem. Specifying what you think is wrong is also useful.

Web: http://www.trading-tools.com  
Forum: http://forum.trading-tools.com
Disclaimer of Warranty

Please note that by using Smart Chart you are accepting the conditions of the Software License and Disclaimer of Warranty given below.

IMPORTANT - READ CAREFULLY

Smart Chart is shareware program. This means:

1. All copyrights are exclusively owned by Trading-Tools.com.

2. Once registered, the user is granted a nonexclusive license to use Smart Chart on one computer (i.e. a single CPU), for any legal purpose, at a time. The registered Smart Chart software may not be rented or leased.

3. To register you must fill out the registration form. For more information please refer to the "Help" files. To purchase, go to http://www.trading-tools.com/order.htm.

4. Smart Chart is distributed "AS IS". No warranty of any kind is expressed or implied. You use it at your own risk. You assume responsibility for selecting the software to achieve your intended results, and for the installation of, use of, and results obtained from the software. The author will not be liable for data loss, damages, loss of profits or any other kind of loss while using or misusing this software and/or any kind of data derived.

5. You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer, or transfer the licensed program, or any subset of the licensed program, except as provided for in this agreement. Any such unauthorized use shall result in immediate and automatic termination of this license and may result in criminal and/or civil prosecution.

6. Trading-Tools.com reserves the right to change the price for the program or any service without prior notice. Trading-Tools.com does not refund the purchases of shareware programs which have trial period.

7. If you do not agree with the terms of this license you must remove Smart Chart files from your storage devices and cease to use the product.

MetaStock™ is a registered trademark of EQUIS International. (http://www.equis.com)

COMMODITY FUTURES TRADING COMMISSION DISCLAIMER

"Hypothetical performance results have many inherent limitations, some of which are described below. No representation is being made that any account will or is likely to achieve profits or losses similar to those shown."
In fact, there are frequently sharp differences between hypothetical performance results and the actual results subsequently achieved by any particular trading program. One of the limitations of hypothetical performance results is that they are generally prepared with the benefit of hindsight. In addition, hypothetical trading does not involve financial risk, and no hypothetical trading record can completely account for the impact of financial risk in actual trading, for example, the ability to withstand losses or to adhere to a particular trading program in spite of trading losses are material points which can also adversely affect actual trading results. There are numerous other factors related to the markets in general or to the implementation of any specific trading program which cannot be fully accounted for in the preparation of hypothetical performance results and all of which can adversely affect actual trading results.

Thank you for choosing Smart Chart!